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Short Movies for the introduction of Excel & Art
Before you start the class of PC to create Excel & Art, these
movies will help you and your students to understand the work.
Nana's Digital World (English, 4 minutes)
https://youtu.be/IystORULsWg

Enjoy! Excel Art | NPO Broadband School Association
（English 3 minutes）https://youtu.be/uPs3es1Vf9w

”Now is the time to get your own wings”
| Masako Wakamiya | TED x Tokyo2014 (English, 10 minutes）

https://youtu.be/gUjXiYtOC7Y（English）
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It must have been around 20 years ago – alongside with caring for my
elderly mother, I started teaching the usage of a computer to
community supporters or women over 60 years of age at my home.
Microsoft Excel (after this Excel)– is a wonderful tool to understand
how a computer can help you with your work or to use digital
technologies and by having an objective, determine the order of how to
achieve your goal and let the computer help you in doing so.
However, many women – especially women over 65 years of age prefer
not to use Excel as they find the application to be difficult and probably
not useful in their daily routine.
On the other hand – many women enjoy knitting ,sewing or embroidery
don`t you think?
In this current 100-year life society, it is crucial to continue to learn and
to be engaged to enjoy your social life. Rather than attend activities
specific for elderly persons, maybe one can turn your home into an
exciting learning facility to enjoy creating artwork using Excel.
I am sure you would initially find it challenging however, challenge can
lead to the joy of achievement.
This activity enhances not only your self-satisfaction but by creating
original handmade gifts, bring smiles to the faces of your good friends
and wonderful family.

Masako Wakamiya
Digital Creator (84)
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Ms. Masako Wakamiya –We (her friends) call her Marchan.
She is 84 years old (as of 2019).
She was the innovator of turning the world`s most commonly used
spreadsheet application – Microsoft Excel – into a tool to enjoy art with
a computer.
It was three years ago, she is most widely known for being the oldest
App developer, with the launch of her iPhone app “Hinadan” in February
of 2017.
Since then there have been many improvements including the addition
of language support in English (2017), Chinese (2018) and Korean
(2019).
After her retirement from the corporate world, she innovated her life
through the usage of a computer which supported her relationship with
the outside world whilst she had to look after her elderly mother.
She joined an internet community “The Mellow Club” which connected
her with others under similar circumstances and eventually opened her
own school to help seniors learn digital skills.
Creating Artwork through Excel was one of the teaching materials which
Marchan developed for her pupils.
This textbook is an ideal introduction for those who are learning digital
skills for the first time, or for seniors who would like to experience the
use of a computer.
I trust that through this material, there would be many who would feel
encouraged to start a new school to learn digital skills - with joy.

Yasutoshi Magara, Chairman,
Specified Non-profit Broadband School Consortium
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Please note that this book is written for the PC beginners.
With that in mind, and also because PC settings vary, this book is written
starting with the basic setup of Excel. However, some steps necessary
for first time computer users has been abridged.

Author Profile
Born in Tokyo in 1935.
Having joined the workforce at Mitsubishi Bank directly following her
graduation from high school.
Masako was unprepared for the loneliness of retirement and the isolation
that came with being a full-time caregiver for her aging mother.
She found her solace in the internet, where she was able to connect with
the outside world.
For the past 20 years she has been teaching PC classes and seminars to
the elderly.
“Excel & Art,” the textbook she developed for teaching Excel to the
elderly, was highly praised at TED x Tokyo in May 2014.
Masako continues to spread her wings, having become a mentor at Digital
Terakoya @Tsuzuki (2018) where she swoops in bringing the joys of
technology to children and adults alike.
Digital Terakoya＠Tsuzuki (Japanese, English, Korean)
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Setting up your canvas in Excel
Set grid height and width to a 1:1 scale
Excel provides an easy to use canvas to create beautiful works of
art simply by changing the colors and shapes of the cells. The steps
introduced in this chapter are standard for all the art projects introduced
in this book. Start by opening up a “blank workbook” in Excel.
At the beginning of every project you must first decide the size of
the grid you want to use. In this first project, we will use a relatively large
square grid as the canvas. First, set the row height to column width to a
1:1 ratio.
① Click on the “select all” button found in the upper left-hand corner of
the worksheet between the row numbers and column letters. This selects
all the cells in the worksheet, including the area not visible on the
computer screen.

② Selected cells will turn gray. (The A1 cell will remain white. Do not
worry about this.) As shown in the image above, all cells in the worksheet
are selected.
③ Next, set the cell size.
Move the mouse to the border line between the A and B column headers.
(An image of a vertical line crossed by a double headed arrow will appear.)
Hold down the mouse button and the width of the columns will be shown
in both points and pixels.
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④ Continue holding down the mouse button while moving to the left or
right until you find the best width for your project. Once you choose your
cell with, note the number of pixels and then release the mouse button.

The number of pixels shown here can be thought of as the cell size. When
the number of pixels is large the cell will be big.
⑤ Next, move the mouse to the light green area on the row numbers.
Hover over the line between 1 and 2. When the icon appears, hold down
the button on the mouse and move the mouse up and down to adjust the
cell height. When the cell’s height and width have and equal number of
pixels, release the button on the mouse. This sets the grid size. For a
standard grid ration of 1:1 the number of pixels in the rows must be equal
to that in the columns.
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This example shows a cell of 20 pixels.

⑥ The canvas has now been prepared to create an Art project using
Excel.

Display the column label as a number
Often times when you want to color cells that are far apart, it is much
easier to have both the columns and rows are both labeled by number.
This is called R1C1 reference style.

① Click on the File tab in the ribbon.
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② Select the Options tab from the lower left of the page

②
③ Next, select Formulas from the column on the left. Check the box
labeled R1C1 reference style found under the heading Working with
formulas and then select OK to set the grid style.

You should now have a grid that looks
like the picture on the left.
Using this Excel setting, you now have
the perfect canvas for creating a variety
of projects.
From now on this will be referred to as
the “Art Canvas.”
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Add frequently used buttons to the Quick Access Tool Bar.
Searching for the functions you want to use from the ribbon takes extra
time and effort. Adding frequently used buttons to the tool bar, will make
your project come together more smoothly.
①
Bar

Right click on the button you want to add to the Quick Access Tool

②

Select “Add to Quick Access Tool Bar”

③ Open the "down triangle ▼" at the right end and click "Show under
the ribbon". The quick access toolbar is easier to use when placed under
the ribbon.

④ The Quick Access Tool Bar Should now look like this:

10

Make a picture using the “Fill” function
You can create a wide variety of designs using only the “Fill” function.

Now try a tradition Japanese design “Sankuzushi”
Set both the cell width and height to 20 pixels. Starting in the second cell
of the top row, shade the cells with alternately dark and light shades of
the same color. (R1C2 to R1C5)

Select the 4 cells you have colored and grab the “fill handle” (+) in the
lower right corner of the selected items and drag it down to the 31 st row.
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Now, select the area from R1C1 to R31C5, copy it and then paste the
selection in the R1C6 cell.

Next, make horizontal stripes on this pattern.
Make the horizontal stripes in the same way as the vertical ones.
Leave the first cell blank, then fill the second to 5th row (R2C1 to R5C1)
in the dark-light-dark-light pattern.
Select and drag the pattern to the right to create horizontal stripes.
Select and copy the horizontal stripes in R1C1 to R5C11.
Paste the pattern into the lower left cell (R6C1).
Repeat pasting for row 11 (R11C1), row 16 (R16C1), row 21 (R21C1) and
row 26 (R26C1).
Next alternate bringing the vertical stripes and the horizontal stripes to
the front in “Sankuzushi” pattern, as shown in the following diagram.
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Have a look at the YouTube video “Enjoy! Excel Art” where I introduce “How to
draw Sanzushi.”
Enjoy! Excel Art | NPO Broadband School Association
（3 minute English Video）

Using “Pattern Style” fill in designs
In Chapters four and five, we will explore using the “Pattern Style” and
shading operations in Excel’s cell functions to make designs. Excel can
be used to make such a wide variety of designs.
The part I enjoy most is coming up with my next design. I feel great when
I have come up with a new and fresh idea. Let your imagination soar and
really experience the feeling of creating original works of art.
Works with a three-dimensional feel can be created like this.

Box pattern
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Table Mat or Table Runner
Compression of the finished design will create a three-dimensional
effect.

Background Color

Red

Pattern Color

Black

Pattern Style Horizontal Stripe
Background Color

Light green

Pattern Color

Black

Background Color

Yellow

Pattern Style

6.25％ Gray

Pattern Color

Black

Pattern Style

Vertical Stripe

Background Color

Blue

Pattern Color

White

Pattern Style Thin Horizontal Stripe

Background Color

Red

Background Color

Yellow

Pattern Color

White

Pattern Color

Orange

Pattern Style Thin Horizontal Stripe

Pattern Style Thin Horizontal Stripe

Background Color

Blue

Background Color

Light green

Pattern Color

White

Pattern Color

White

Pattern Style

Horizontal Stripe

Pattern Style Thin Horizontal Stripe
14

Designing with the shading effect
The “Fill” function in Excel also contains a selection of shading options.
This allows for gradation of cells and light effects to be created in your
designs.
Look at how the shading in the images below create a three-dimensional
feel.

Creating a convex or pop-out effect
Let’s make a pattern, combining different types of shading.

Select the cells you want to color, and open the “Fill” tab under “Format
Cells”. Click “Fill Effects” and select the 1st and 2nd colors you want to
use in the gradation.
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For a concave feel, choose a dark color as the first color and white as the
second. (The second is the color in the middle.)

When the second color is dark, the surrounding color is white. Choose the
shading style from the list at the bottom left of your “Fill Effects”
window. Within each there are several variants to choose from.
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Creating a blurred effect
Here’s and example of the “blurred effect”.

① Select and area to be filled and choose the base color (a dark color is
recommended). You can adjust the size of your work area later if needed.
② Set either color 1 or color 2 to your base color. Now select “from
corner” under “Shading Styles.”
③ To darken the area where the 4 cells join together, make the second
color darker. Try a different arrangement for each.

Customizing your fans and paper bags
You can use the techniques that you have learned in this book to
customize fans and paper bags. In this chapter I will explain how.
In Japan during the summer, there are fans with advertisements on them
being passed out everywhere you go. Also, whenever you buy something
in department stores you end up with high quality paper bags from almost
every store you shopped at. These are great things to get, if only they
didn’t have the store logos on them. Rather than throwing them away,
why not use your newly acquired Excel skills to give these items new life?
Creating matching fans for when you attend the summer festival with
your friends. Customizing small bags for gifts. These are wonderful ideas
to repurpose items and make them fresh, useful and original. So, enjoy
night dancing with your friends at the obon festival, each one of you
carrying a matching but uniquely designed fan.
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Making a fan (Uchiwa)
Self-adhesive paper that can be cut in many shapes and sizes is readily
available online or at the 100 yen shop. Just print out your design, cut it
out and stick it on to the item you want to decorate and your all finished.

Decorate your paper bags in the same way.
Self-adhesive paper is sold in several
weights, choose the one best for your project.
Video Customize a Paper Bag with your own Excel Design
(5 minute English video)

Nana's Digital World

https://youtu.be/IystORULsWg
Emma is the daughter of the actress
Mako Hattori.
Maiko Hattori serves as the deputy director of
the NPO Broadband School Association and
also narrated the English version of my App
“Hinadan.”
In this video Emma had just graduated
University, but now she is happily married and
living in the United States with her husband
and daughter.
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Draw Mount Fuji
Let’s draw Mount Fuji using the “Borders” function.
The crisscross pattern results in an embroidery like design.

① Start by making the “X” part of the design.

To make the green “X” for the trees, following the diagram below, open
the “Border” tab in the “Format Cells” window and select the thick line
from “Line Styles.” Change the line color to green and then click on both
the “Diagonal up” and the “Diagonal down” borders to create an “X” in
the cell.

Please change the colors of the “X” used in the design according to your
taste.
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The trunk of the tree is made using a “Pattern Fill.” In the example, the
“Background Color” is dark brown and the “Pattern Color” is orange. The
“Pattern style is set to vertical lines.

The outline of the design is created using the “Merge” function.

To merge cells, select the cells you want to join together, then click on
the “Merge & Center” button.

Transform Designs with 3D Builder
Using the Windows Accessory, “3D Builder” your designs can be
transformed in new and exciting ways by adding a three-dimensional
effect.
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Instructions
① Open the start menu in Windows 10 and scroll to and expand the
“Windows Accessory” folder. Select “3D Builder” to open it.

② Once “3D Builder” has started up, select “New
Scene” from the menu.
③ Select “Add” from “Insert” tab

④ Select the design which you created earlier.

⑤ Start by leveling out your image. Move the mouse around in the
margin of to change the view of the image. Adjust your image until it is
rectangular. Initially, the “Method” will be set to “Contour”.
⑥ Start by setting the “Level” and “Contour” to zero. Then change the
“Method” to “Height Map” or “Edge”.
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⑦ Once you have chosen the “Method”, try out different settings in
“Levels” and “Smooth”.

Image captured using Snipping Tool.

☆ Some designs are not suitable for 3D rendering.

Using the “Snipping Tool”
A book cover or bookmark cannot be made directly in the Excel window,
but they can be created easily in the Windows Accessory, “Snipping
Tool”.
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① In the Start Menu, there is a Windows Accessory called “Snipping
Tool”.
② Before using the snipping tool, open the “View” tab in the ribbon.
Uncheck the view “Gridlines” box.
③ When you open the “Snipping Tool” a window will popup.
④ Click on “New” and a transparent film will appear over the screen.
Select the area you want to copy.
⑤ Now, as shown in image “A”, you can save the picture by opening “File”
and selecting “Save As”. Also, you can copy the design as shown in image
“B”. Go to the “Edit” tab and select “Copy”. You are now able to paste
the copied image into any document you like.
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Turn your designs into Fashionable Items
This is a dress I wore to the Japanese Imperial Autumn Garden Party.
It’s made from satin that was printed with the rose design that I created.

The Empress Michiko admired the bag made using iron beads, it
incorporates LED lights into the design to create a special effect.
I designed the bag using Excel and the lights were programmed using
IchigoJam Basic.

The organdy shawl I wore, uses a block design I created using Excel.
I love the ocean, so I had some fabric
printed with my sailboat design and
used it to line these reversible tote bags.

Marchan’s Crafting with Computers 2019
Enjoy Excel Art Microsoft Excel 2016
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